Digital Image Classification

- Uses the spectral information represented by the digital numbers in one or more spectral bands.

- Classifies each individual pixel based on this spectral information. Also known as spectral pattern recognition.

  **The objective:** To assign all pixels in the image to particular classes or themes (e.g., water, coniferous forest, deciduous forest, crops, bare soil, etc.)
Digital Image Classification

Raster Values:
- TM 1 = 32
- TM 2 = 79
- TM 3 = 30
- TM 4 = 174
- TM 5 = 88
- TM 7 = 25

Spectral Plot

Landsat Thematic Mapper Raster Set

Raster cell position

Wavelength (micrometers)

Raster Value

TM 1
TM 2
TM 3
TM 4
TM 5
TM 7
Digital Image Classification

multispectral feature-vector

= \{108, 91, 34, 23\}

David P. Lusch, Ph.D.     GEO 827 – Digital Image Processing and Analysis
Digital Image Classification

The two approaches:

- **Per-pixel classification**
  - The algorithm categorizes each input pixel into a spectral feature class based solely on its *individual multispectral vector* (signature). No context or neighborhood evaluation is involved.

- **Object-oriented classification**
  - The input pixels are grouped into spectral features (objects) using an *image segmentation algorithm*. These objects are characterized in both the raster and vector domains. The objects are classified using both spectral and spatial cues (metrics).
Digital Image Classification

- The three common **per-pixel** methods are:
  - Supervised classification
  - Unsupervised classification
  - Rule-based classification
Digital Image Classification

- **Supervised classification**
  - The analyst "supervises" the categorization of a set of specific classes by providing *training statistics* that identify each category.

- **Unsupervised classification**
  - The raw spectral data are grouped first, based solely on the statistical structure of the data. Then the analyst must label each statistical cluster, placing them into the appropriate categories (if possible).

- **Rule-based classification**
  - Spectrally categorized pixels are classified using ancillary data in a GIS model.
Digital Image Classification

- **Supervised classification**
  - In the imagery, the analyst identifies homogeneous, representative examples of the various surface cover types (information classes) of interest.
  - These samples are referred to as **training areas**.
  - The selection of appropriate training areas is based on the analyst's familiarity with the geographical area and their knowledge of the actual surface cover types present in the image.
  - **Good visual interpretation skills are mandatory for success.**
Digital Image Classification

- **Supervised classification**

![Diagram](image_url)

- **Training Sites**
  - Conifers
  - Water
  - Deciduous

- **Spectral Signatures**
  - Conifer
  - Water
  - Deciduous

- The computer software compiles spectral signatures from training sites and uses them to classify all unknown pixels.
Digital Image Classification

- Supervised classifiers (algorithms)
  - Parallelepiped – based on range or variance of class DNMs
  - Minimum Distance-to-Means – based on mean class DNMs
  - Maximum Likelihood – based on probability of class membership
  - Spectral Angle Mapper – class membership based on minimum difference from the $n$-dimensional spectral vectors of the classes
Digital Image Classification

- **Supervised classification process**

  - **Step 1: Define training data**
    - Each training site should appear homogenous and representative of the legend class
    - Delineate several training sites for each legend class
    - Make each training site at least 20-25 pixels (i.e., > 5 acres for 30 meter pixels)
    - Each class should be represented by ~ 100 $n$ pixels ($where n = number of spectral bands in the data set$)
Digital Image Classification

- **Supervised classification process**
  - **Training Sites**
    - For 6-band TM & ETM imagery, the total number of training pixels per class should be at least 600.
    - Try to capture the landscape diversity of the class.
Digital Image Classification

- Example of a homogeneous training site

- Check all bands

- GOOD!
Digital Image Classification

- Example of a heterogeneous training site
Digital Image Classification

- **Supervised classification process**
  - **Training data**
    - Should be *normally distributed* if the maximum likelihood classifier is going to be used
Digital Image Classification

- **Supervised Classification Process**
  - Collect several training sites for each class in order to capture the landscape diversity of the class

![Histograms showing the advantage of individual signatures](Image)

- **A dark version of class 1**
- **A bright version of class 1**

The advantage of individual signatures: separate mean DN values and **small variances**
Digital Image Classification

- Supervised Classification Process

  - For variable classes *do NOT* merge signatures

![Diagram showing histograms of DN values for darker and brighter DN areas with mean and standard deviation](image)

The disadvantage of merged signatures:
shifted mean DN value *(atypical of the class)* and a large variance
Supervised Classification

- **Training Sites** – Tools in ERDAS Imagine
  - **Drawing tab:** Insert Geometry Tools
    - Polygon tool
    - Region Grow tool
Supervised Classification

Polygon tool
Supervised Classification

- **Drawing Tools → Region Grow tool**

**Step 1:** Set Seed Properties:
Supervised Classification

Drawing Tools → Region Grow tool

**Step 2:** Select a seed pixel with the Region Grow Tool:

*Selected seed pixel*

*Grown region*

*Note excluded areas*
Supervised Classification

- **Drawing Tools → Region Grow tool**

**Step 3:** Evaluate Spectral Euclidean Distance:

- Spectral Euclidean Distance = 15
- Spectral Euclidean Distance = 5

*Using 8-bit imagery*

With 16-bit imagery, SED ~ 900 to 2000 are appropriate

David P. Lusch, Ph.D.  GEO 827 – Digital Image Processing and Analysis
Supervised Classification

- **Training Sites** – Tools in ERDAS Imagine
  - Raster tab → Classification Group → Supervised

- Signature Editor
Supervised Classification

- **Training Sites** – Tools in ERDAS Imagine
  - Signature Editor → Create New Signature(s) from AOI(s)
Supervised Classification

- **Training Sites** – Tools in ERDAS Imagine
  - Signature Editor → **Evaluate each new signature**

- **Signature Editor**
  - Rename the class to something meaningful
  - Change color to **Yellow** for Image Alarm evaluation
Supervised Classification

- Training Sites – Tools in ERDAS Imagine
  - Signature Editor → View → Image Alarm
Supervised Classification

- Signature Editor → View → Image Alarm

1. Indicate Overlap
2. Edit Parallelepiped Limits...
3. Set Parallelepiped Limits

2 SD eliminates the darkest and brightest 2.3% of the data

David P. Lusch, Ph.D. GEO 827 – Digital Image Processing and Analysis
Supervised Classification

- Signature Editor → View → Image Alarm

- Set Std. Deviation between:
  - 2.00 (95.4% of the data)
  - 3.00 (99.7% of the data)
    - 1.00 SD = 68.3% of the data

Rationale: Eliminate the most atypical pixel values from consideration.

Image Alarm uses the simple Parallelepiped classifier in which each class is defined as an n-dimensional volume whose boundaries in brightness space are set by these limits.
Supervised Classification

- Visually evaluate Image Alarm for:
  - Errors of Omission
  - Errors of Commission
Supervised Classification

- **Errors of Omission**
  - Indicates the need for **and location of** additional training sites to adequately capture the spectral variability of the class in question.

![Image of classified data](image-url)
Supervised Classification

Errors of Commission

- Indicates that the training site is not spectrally “pure” regarding the assumed land cover/use class.

- The analyst must go back to “constrict” the training site (spectrally) by editing the existing training polygon or drawing a new one.

- General rule: “Do no harm” (i.e., it is better to leave some pixels unclassified (omission errors) rather than to have large commission errors).
Digital Image Classification

- **Maximum Likelihood Probability classifier**
  - **Without A Priori Probability Information**
    - Decide unknown measurement vector $X$ is in class $i$ if, and only if, $p_i > p_j$ for all $i$ and $j$ out of $1...m$ possible classes and
    
    $p_i = \frac{1}{2} \log_e | V_i | - \left[ \frac{1}{2} (X - M_i)^T V_i^{-1} (X - M_i) \right]$

    Where $| V_i |$ is the determinant of the covariance matrix, $(X - M_i)^T$ is the transpose of the vector $(X - M_i)$ and $V_i^{-1}$ is the inverse of the covariance matrix. $M_i$ is the mean measurement vector for class $i$, and $V_i$ is the covariance matrix of class $i$ for bands $k$ through $l$. Therefore, to assign the measurement vector $X$ of an unknown pixel to a class, the maximum likelihood decision rule computes the value $p_i$ for each class and assigns the pixel to the class that has the largest (or maximum) value.
Digital Image Classification

- Maximum Likelihood Probability classifier
  - Without A Priori Probability Information
    - The mean vectors $M_i$ and covariance matrix $V_i$ for each class are estimated from the training data.

$$p_i = \frac{1}{2} \log_e |V_i| - \left[ \frac{1}{2} (X - M_i)^T V_i^{-1} (X - M_i) \right]$$

Where $|V_i|$ is the determinant of the covariance matrix, $(X - M_i)^T$ is the transpose of the vector $X - M_i$ and $V_i^{-1}$ is the inverse of the covariance matrix. $M_i$ is the mean measurement vector for class $i$, and $V_i$ is the covariance matrix of class $i$ for bands $k$ through $l$. Therefore, to assign the measurement vector $X$ of an unknown pixel to a class, the maximum likelihood decision rule computes the value $p_i$ for each class and assigns the pixel to the class that has the largest (or maximum) value.
Digital Image Classification

Maximum Likelihood Probability classifier

Unknown pixels:
- 1
- 2
- 3

- Unknown pixel 1 is assigned to class H because $p_{1H} > p_{1R} >> p_{1J}$

- Unknown pixel 2 is assigned to class R because $p_{2R} > p_{2J} >> p_{2H}$

- Unknown pixel 3 is assigned to class R because $p_{3R} > p_{3H} >> p_{3J}$

n-dimensional class means

NIR Brightness Value

Red 5 Brightness Value

October 2015
Digital Image Classification

Maximum Likelihood Probability classifier

Probability Density Functions Derived from Multispectral Training Data

- Forest
- Cotton
- Corn
- Bare soil
- Water
- Wetland

Adapted from Jensen, 2005
Digital Image Classification

Maximum Likelihood Probability classifier

- Advantages
  - Sensitive to both variance and covariance in the training data

- Disadvantages
  - Training data must be normally distributed
  - The per-pixel, rather than pixel neighborhood approach, remains a problem
Digital Image Classification

- Maximum Likelihood Probability classifier
- Multi-band Variance, Covariance and Correlation

\[ p = 1 \]
\[ 0 < p < 1 \]
\[ p = 0 \]
\[ -1 < p < 0 \]
\[ SD_x = SD_y \]
\[ SD_x \neq SD_y \]
Digital Image Classification

Maximum Likelihood Probability classifier

Variance – Covariance Matrix

\[ \sigma_{11}^2 = 5192.16 \quad \sigma_{12}^2 = 3866.65 \quad \sigma_{13}^2 = 2722.83 \quad \sigma_{14}^2 = 1094.98 \]
\[ \sigma_{22}^2 = 3781.67 \quad \sigma_{23}^2 = 2520.50 \quad \sigma_{24}^2 = 1462.00 \]
\[ \sigma_{33}^2 = 4806.52 \quad \sigma_{34}^2 = 3652.66 \quad \sigma_{44}^2 = 3927.78 \]

Sum of variances = 17708.13

4-band data set (range 0 – 255)

- Mean band 1 = 129.29
- Mean band 2 = 106.63
- Mean band 3 = 104.71
- Mean band 4 = 121.80
Supervised Classification

- **Maximum Likelihood Classifier**
  - Raster tab → Classification Group → Supervised

![Image of Supervised Classification interface]
Supervised Classification

- **Maximum Likelihood Classifier**
  - All pixels are classified initially, irrespective of how low the probabilities of class membership are.
  - *E.g.*, assume the probabilities of pixel $i$ belonging to one of eight classes is:
    - $p_1 = 0.0125$
    - $p_2 = 0.0237$
    - $p_3 = 0.0105$
    - $p_4 = 0.0095$
    - $p_5 = 0.0275$
    - $p_6 = 0.0078$
    - $p_7 = 0.0083$
    - $p_8 = 0.0195$

Pixel $i$ is assigned to Class 5 even though its probability of class membership is only 2.75% (*i.e.*, it’s 97.25% likely to NOT be a member of Class 5 (and even less likely to be a member of any other class).
Supervised Classification

- **Maximum Likelihood Classifier**
  - **Threshold tool** (Raster tab → Supervised → Threshold)
    - **Thresholding** is a statistical method used to refine a supervised classification by determining which pixels in the new thematic raster layer are most likely to be incorrectly classified (using the distance file that was created during the supervised classification). These distances occur in probability space, so larger distances are associated with lower probabilities of class membership.

    - The histogram of the distance file usually approximates a chi-square distribution. Normally, there are many pixels with a distance image value at or near 0, indicating that these pixels are likely to be classified correctly. A histogram is generated for each class in the classified image file.

    - Analyst displays, inspects and edits (thresholds) each histogram. The rejected pixels become “unclassified.”
Supervised Classification

- **Maximum Likelihood Classifier**
  - Threshold tool (Raster tab → Supervised → Threshold)

![Distance Histogram (Water1)](image)

- Keep
- Reject

![Threshold dialog box](image)

- Class Name: Water1, ChiSquare: 12.690
- Water2, ChiSquare: 12.590
- Dec_Fo1, ChiSquare: 12.590
- Conif_Fo1, ChiSquare: 12.590
- Herbaceous_brown, ChiSquare: 12.590
- Herbaceous_green, ChiSquare: 12.590
- Conif_Fo2, ChiSquare: 12.590
- Dec_Fo2, ChiSquare: 12.590

Parameters:
- Confidence Level: 0.050
- Classification Type: Maximum Likelihood
Digital Image Classification

- **Spectral Angle Mapper**
  - n-dimensional vectors

Hyperangle $\alpha < \beta$, So the *Unknown* pixel is classified as a member of class “A”
Spectral Angle Mapper

\[ \alpha = \cos^{-1} \left( \frac{\sum_{i}^{nb} t r}{\left( \sum_{i}^{nb} t_i^2 \right)^{1/2} \left( \sum_{i}^{nb} r_i^2 \right)^{1/2}} \right) \]

Where \( nb \) is the number of bands in the image, \( t \) is the unknown pixel spectrum, and \( r \) is reference spectrum.
Digital Image Classification

- **Spectral Angle Mapper**
  - Given a set of reference signatures collected from an image with \( m \) bands, the SAM classifier performs the following two steps:
    - **Step 1**: Determine the spectral angle \( \theta_{i,r} \), between a pixel \( i \) in the image and every reference class \( r \):
      \[
      \theta_{i,r} = \cos^{-1}\left(\frac{\sum_{m} t_{i,m} r_{r,m}}{\sqrt{\sum_{m} t_{i,m}^2} \sqrt{\sum_{m} r_{r,m}^2}}\right)
      \]
Digital Image Classification

- **Spectral Angle Mapper**

  - *Step 2*: Assign each pixel to the reference class $r$ that has the smallest spectral angular distance between pixel $i$ and reference class $r$. For each pixel $i = 1$ to $n$, find the reference class $r$ such that the $\theta_{i,r}$ is the minimum of all reference classes.
Digital Image Classification

- **Spectral Angle Mapper Classifier**
  - **Advantages**
    - Often more accurate than maximum likelihood
    - Less sensitive to illumination differences
  - **Disadvantages**
    - Numerous training spectra required to describe the "best" mean vector for each class
Supervised Classification

- **Spectral Angle Mapper**
  - Raster tab → Classification Group → Supervised
Supervised Classification

- **Image Classification**
  - Classifications can always be improved - perfection is rarely possible, especially using precise LULC categories
  - Per pixel classification works best with moderate spatial resolution imagery (GSD $\geq 20$ meters)
  - The classification process is iterative – it’s rare to have high classification accuracy after the first attempt
  - Consider a hybrid classification – part supervised, part unsupervised (especially in areas where your field experience is limited)
  - Manual Classification and/or Editing is not cheating, but can be extremely time consuming
Digital Image Classification

- **Supervised classification**
  - The analyst "supervises" the categorization of a set of specific classes by providing *training statistics* that identify each category.

- **Unsupervised classification**
  - The raw spectral data are *grouped first*, based solely on the statistical structure of the data. Then the analyst must label each statistical cluster, placing them in the appropriate categories (if possible).

- **Rule-based classification**
  - Spectrally categorized pixels are classified using ancillary data in a model.
Unsupervised Classification

- Requires only minimal initial input from the analyst.

- However, the analyst has the task of interpreting the many classes that are generated by the unsupervised classification algorithm.

- Unsupervised classification is also called **clustering**, because it is based on the natural groupings of pixels in image data when they are plotted in feature space.
Unsupervised Classification

- Clusters are defined with a clustering algorithm.
- The clustering algorithm has **no regard for the contiguity** of the pixels that define each cluster unlike the training areas for supervised classification.

- The **Iterative Self-Organizing Data Analysis** – **ISODATA** clustering method uses spectral distance and iteratively classifies the pixels.
  - After each iteration, ISODATA redefines the criteria for each class, and classifies again, gradually “discovering” the spectral distance patterns (*i.e.*, the clusters) in the data.
Unsupervised Classification

- The initial cluster means are evenly distributed across the feature space along a vector that runs from the
  - multidimensional $-1 \sigma (\mu_1-\sigma_1, \mu_2-\sigma_2, \mu_3-\sigma_3, \ldots \mu_n-\sigma_n)$
  to the
  - multidimensional $+1 \sigma (\mu_1+\sigma_1, \mu_2+\sigma_2, \mu_3+\sigma_3, \ldots \mu_n+\sigma_n)$
Unsupervised Classification

- ISODATA Initialization

5 arbitrary cluster means in two-dimensional spectral space

User specified number of clusters

Band B data file values

Band A data file values

\( \mu_{B} \pm \sigma_{B} \)

\( \mu_{A} \pm \sigma_{A} \)
Unsupervised Classification

- ISODATA uses minimum spectral distance to assign a cluster for each candidate pixel.
  - The process begins with a user-specified number of arbitrary cluster means (or the means of existing signatures).
  - With each iteration, the means shift to those of the clusters in the data.
  - Because ISODATA is iterative, it is not biased to the top of the data file, as are the one-pass clustering algorithms.
  - The spectral distance between any candidate pixel and each cluster mean is calculated and the pixel is assigned to the cluster whose mean is the closest.
Unsupervised Classification

- Multispectral Feature Space
Unsupervised Classification

ISODATA first pass

Adapted from Jensen 2005
Unsupervised Classification

ISODATA second pass

New multi-band cluster means

New cluster boundaries

Adapted from Jensen, 2005
Unsupervised Classification

ISODATA $n^{th}$ pass

ISODATA $n^{th}$ Iteration
Mean Vector Assignment
and Partition of Feature Space

Final cluster boundaries

Final multi-band cluster means

Adapted from Jensen, 2005
Unsupervised Classification

Distribution of ISODATA
Mean Vectors after 1 Iteration

Distribution of brightness values

Ellipses depict $\pm 2\sigma$

Distribution of ISODATA
Mean Vectors after 20 Iterations

Adapted from Jensen, 2005
Unsupervised Classification

- **ISODATA** in ERDAS *Imagine*
  - Raster tab → Classification Group → Unsupervised

Use only for hybrid classification:
1. ISODATA of small, representative area
2. Cluster interpretation by analyst
3. Cluster Signature Set used in Maximum Likelihood classifier (with multiple same-class sigs colored the same)
Unsupervised Classification

**ISODATA** in ERDAS Imagine

**Step 1**
- Input Raster File: `*.img`
  - `lansing_sub.img`

**Step 2**
- Output Cluster Layer
  - Filename: `*.img`

**Step 3**
- Output Signature Set
  - Filename: `*.sig`

**Step 4**
- Initialize from Statistics
- Use Signatures Means
- K-Means
- ISODATA

**Step 5**
- Minimum Size = 1 – 5%
- Maximum SD = 3.0 – 4.0
- Maximum Merges = 10 – 15
- Minimum Distance = 4 – 5
  (for 8-bit images)

**Step 6**
- As a general rule, this should be at least 3x the number of legend classes you desire + 3 – 5 more

**Step 7**
- Minimum Size = 1 – 5%
- Maximum SD = 3.0 – 4.0
- Maximum Merges = 10 – 15

David P. Lusch, Ph.D.  GEO 827 – Digital Image Processing and Analysis
Unsupervised Classification

**ISODATA in ERDAS Imagine**

**Step 8**
- Maximum Iterations: 10
- Convergence Threshold: 0.950

**Step 9**
- Typically requires 15 – 20 iterations to stabilize (35 – 40 for 16-bit images)

**Step 10**
- Set to 0.95 (0.96– 0.98 will take many more iterations)

**Step 11**
- Set to X:1, Y:1 (i.e., do not skip any pixels)
Unsupervised Classification

- After each iteration, the normalized percentage of pixels whose assignments are unchanged since the last iteration is determined.

- When this number reaches $T$ (the convergence threshold), the program terminates.

- As a QA check, ensure that the program terminated because it reached the convergence threshold and not because it reached the maximum number of iterations.
Unsupervised Classification

File → Session → View Session Log

Performing iteration: 1 Convergence: 0.000
Performing iteration: 2 Convergence: 0.260
Performing iteration: 3 Convergence: 0.525
Performing iteration: 4 Convergence: 0.862
Performing iteration: 5 Convergence: 0.920
Performing iteration: 6 Convergence: 0.938
Performing iteration: 7 Convergence: 0.949
Performing iteration: 8 Convergence: 0.957
Unsupervised Classification

20 Clusters
6 Iterations
Unsupervised Classification

- Cluster Labeling → Attribute Table

Right-click for pop-up menu.
Select “Display Attribute Table”

Attribute Table

David P. Lusch, Ph.D. GEO 827 – Digital Image Processing and Analysis
## Unsupervised Classification

### Cluster Labeling → Attribute Table

1. Left-click on Opacity column heading to select all

2. Right-click on Opacity column heading to open “Column Options” pop-up menu

3. Select “Formula” from menu

<table>
<thead>
<tr>
<th>Row</th>
<th>Histogram</th>
<th>Value</th>
<th>Value</th>
<th>Value</th>
<th>Value</th>
<th>Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>1</td>
<td>1415642</td>
<td>0.035</td>
<td>0.035</td>
<td>0.035</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>2</td>
<td>1155561</td>
<td>0.071</td>
<td>0.071</td>
<td>0.071</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>3</td>
<td>87227</td>
<td>0.106</td>
<td>0.106</td>
<td>0.106</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>4</td>
<td>128141</td>
<td>0.141</td>
<td>0.141</td>
<td>0.141</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>5</td>
<td>173</td>
<td>0.18</td>
<td>0.18</td>
<td>0.18</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>6</td>
<td>246043</td>
<td>0.216</td>
<td>0.216</td>
<td>0.216</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>7</td>
<td>11610</td>
<td>0.251</td>
<td>0.251</td>
<td>0.251</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>8</td>
<td>3885</td>
<td>0.286</td>
<td>0.286</td>
<td>0.286</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>9</td>
<td>22280</td>
<td>0.322</td>
<td>0.322</td>
<td>0.322</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>10</td>
<td>102860</td>
<td>0.357</td>
<td>0.357</td>
<td>0.357</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>11</td>
<td>400200</td>
<td>0.392</td>
<td>0.392</td>
<td>0.392</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>12</td>
<td>24912</td>
<td>0.427</td>
<td>0.427</td>
<td>0.427</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>13</td>
<td>573</td>
<td>0.463</td>
<td>0.463</td>
<td>0.463</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
<tr>
<td>14</td>
<td>236</td>
<td>0.498</td>
<td>0.498</td>
<td>0.498</td>
<td></td>
<td></td>
<td>Class 1</td>
</tr>
</tbody>
</table>

David P. Lusch, Ph.D.  GEO 827 – Digital Image Processing and Analysis
Unsupervised Classification

☐ Cluster Labeling → Attribute Table
Unsupervised Classification

Cluster Labeling → Attribute Table

Inspect the included LULC classes in each cluster using the SWIPE tool (HOME tab)
Unsupervised Classification

Cluster Busting

- It is common when performing unsupervised classification that the algorithm will generate $n$ clusters, but you have no confidence in labeling $q$ of them to an appropriate information class (e.g., 15 out of 30 clusters contain multiple LULC categories).

- **Step 1** - all the pixels associated with the 15 clusters that are mixed (e.g., clusters 3, 5, 6, 9, 11, 13, 15, 17, 18, 20, 22, 23, 25, 28 and 30) are all **RECODED** to a value of 1 and a **binary mask file** is created.

- **Step 2** - A mask program is run multiplying the binary mask file times the original imagery file. The output of the mask program is a new multiband image file consisting of **only the pixels that could not be adequately labeled during the initial unsupervised classification**.
Unsupervised Classification

Cluster Busting

- **Step 3** - Perform a new unsupervised classification on the output file from Step 2, perhaps requesting the original number of clusters.

- **Step 4** – Repeat Steps 1 and 2, keeping all of new clusters that are dominated by a single LCLU (e.g., 7). There are likely still some mixed-class clusters, but the proportion of these is definitely smaller.

- **Step 5** - Repeat Step 3 performing a third iterative unsupervised classification. Perhaps an additional 3 good clusters are extracted.
Unsupervised Classification

Cluster Busting

- In this hypothetical example, the final cluster map would be composed of:
  - 15 good clusters from the initial classification,
  - 7 good clusters from the first cluster-busting pass (recoded as values 31 to 38), and
  - 3 good clusters from the second cluster-busting pass (recoded as values 39 to 41).

- The final cluster map file is re-assembled using a simple GIS maximum-dominate overlay function. The final cluster map is then recoded to create the final classification map.